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Introducció

El Gimp (de GNU Image Manipulation Program), és una excel·lent aplicació de programari lliure que ens permet l'edició
d'imatges "pixelades" utilitzant un còmode entorn gràfic, en els principals sistemes operatius (GNU/Linux, Mac, Window$).

Salta a...
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"Píxel"? El vídeo digital, les fotografies, les icones del nostre escriptori,... són imatges pixelades o de mapa de bits.
Les imatges estan formades per píxels (Picture Element, amb forma quadrada). Cada píxel conté la informació d'un sol
color i l'agrupació de varis píxels formen la imatge.

L'alternativa a les imatges pixelades són les imatges vectorials, que es poden fer més grans sense perdre qualitat (les
imatges pixelades perden qualitat), i solen ocupar molt menys espai de disc. L'eina recomanada de programari lliure
multiplataforma per treballar amb imatges vectorials és l'Inkscape, que treballa per defecte amb el format .svg, però n'hi
ha molts altres programes i formats per imatges vectorials (Corel Draw, Free Hand, Il·lustrator, ...), la majoria de
pagament i programari propietari. Amb el Gimp podem treballar les imatges pixelades o de mapa de bits.

El Gimp té moltíssimes opcions pre-instal·lades, i moltíssimes més afegibles com a mòduls, connectors (plugins),
funcions, etc.; la gestió de totes elles es fa des dels seus menús respectius, i es poden veure totes les instal·lades des
de "Ajuda > Gestor de connectors" (o des del menú desplegable d'Extensions en les versions 2.4.*):

Un cop oberta una imatge, podem accedir sempre a totes les opcions del Gimp clicant amb el botó contrari del ratolí a
sobre de la imatge.

Formats d'arxius

El Gimp pot treballar amb molts arxius d'imatge, incloent fins i tot alguns arxius típics de programes propietaris com
Adobe Photoshop, Paint Shop Pro i Corel Photo Paint.

El format nadiu del Gimp és el xcf, que és el format en el que ens convé gravar les nostres imatges mentre
estiguem treballant amb elles i mentre no siguin definitives, doncs manté la informació dels objectes que tinguem en
capes, etc.

Quan vulguem distribuir les nostres imatges acabades, podrem fer servir tipus d'arxius més compactes. D'aquests
n'hi ha de dos tipus: amb pèrdua d'informació (lossy) i sense pèrdua (lossless).

Els formats d'arxiu amb pèrdua emmagatzemem les imatges amb un gran nivell de compressió, amb el que ocupen
menys espai a disc dur, a costa de perdre qualitat en les imatges. Per imatges destinades a la pantalla d'ordinador,
sovint no es noten massa els canvis, però quan les imatges van destinades a ser impreses en paper, llavors la qualitat
és molt pitjor. El format més popular és jpg.

1.

Els formats d'arxiu sense pèrdua emmagatzemen les imatges sense degradar la seva qualitat. Els formats més habituals
són bmp, png i el tiff (la majoria de programes que treballen amb formats png i tif poden comprimir les imatges, d'un
altre forma a com es fa amb el jpg, de forma que no es perd qualitat). El format TIF el solen demanar empresses d'arts
gràfiques, i el solen donar també alguns escànners. el format .png s'usa molt en pàgines web i fons de pantalla, i permet

2.
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definir el color de fons com a transparent.

Mides dels arxius d'ordinador

A l'hora de treballar amb imatges, és molt important tenir present que volen dir les diferents unitats de mida del pes de les
imatges (la quantitat d'informació que contenen).

Equivalències: 0.001 Gb = 1 Mb = 1.000 Kb = 1.000.000 bytes

Exemples de capacitat:

  Disquet de 3.5 polsades: 1.44 Mb
  Llapis de memòria: 128 Mb, 256 Mb, 512 Mb, 1 Gb ... fins a 32 Gb fàcilment.
  CD: 700 Mb
  DVD: 4.5 Gb

Les fotos o imatges per a un document estàndard que ocupin tota l'amplada d'un full DINA4 no cal que "pesin" més de 200
Kb, com a referència, sense que es noti mala qualitat de la imatge en una impressora estàndard (imatges amb 72 dpi de
definició - dpi = punts per polsada, en anglès -).

Les fotos per al perfil de l'usuari d'aquest campus virtual poden pesar menys de 10 kb fàcilment, sense que es noti a la
mida a la que es mostra la imatge tant en mida petita als fòrums, per exemple, com a la pàgina del perfil de l'usuari.

Instal·lació del Gimp

Descàrrega: URL base: http://www.softcatala.org/wiki/Gimp

Per GNU/Linux: la majoria de les distribucions de GNU/Linux ja porten instal·lat alguna versió de Gimp entre la 2.2.x
i la 2.6.x. En cas que no hi sigui, aneu a http://www.gimp.org/unix per descarregar els paquets binaris o el codi font.
Per Windows 2000, XP o superior, en català versió 2.6.x a la pàgina de Softcatalà.
Per Windows 95, 98 o ME cal baixar-se versions més antigues del Gimp com 1.2.4, 2.0.5 i 2.2.3
Per canviar l'idioma a català

Per a Gimp anterior a 2.6.0 (p.e.: 2.4.4), des del menú del Windows: Inicia -> Programes -> Entorn GTK+ -> Configura
Idioma
Per a Gimp igual o superior a 2.6.0, es mostra l'idioma del sistema operatiu. Per disposar de Gimp en català, cal
instal·lar (si no el teniu encara) el paquet de Català per al vostre sistema operatiu. (Veure paquet gratuït de Windows
XP en català).

Manuals i tutorials

Els tutorials i 'howtos' són explicacions pas a pas per fer coses concretes: capes, animacions, efectes...

Pdf's descarregables introductoris en català:

Fascicle 4: Gimp i Inkscape (PDF), fascicle sobre el GIMP a la campanya d'alfabetització digital de l'Ajuntament de
Barcelona.
El GIMP i l'Inskape, colors per als teus ulls, Capítol 6 del Manual d'Iniciació al programari lliure, de l'Ajuntament de
Rubí.
Introducció al Gimp 2.0, Manual breu de Raimon Esteve - www.codilliure.org (i activitat relacionada).

Tutorials html en català

Veure enllaços al Wiki de Softcatala

Tutorials en anglès

http://www.tuxradar.com/gimp (sèrie molt bona de tutorials!)

Manuals extensos (html o .odt, en anglès o català):

El manual oficial, i de pas un excel·lent exemple d'e-book en HTML (en anglès)
Grokking the Gimp, un altre manual (i un altre bon e-book) (en anglès)

Vídeo Tutorials (video podcasts)

http://tatica.org/category/gimp100podcast/ De Tatica, en castellà i anglès. Molt bons.

Altres:

L'article a la wikipedia (català)
L'article a la wikipedia (castellà)

Edició d'imatges digitals amb Gimp
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Interfície de Treball

Un cop obert el programa, es veurà una finestra de l'estil de la que es mostra aquí sota:

Hi ha tot un conjunt de botons per:

fer seleccions de trossos d'una imatge...
per seleccionar regions a partir de camins de nodes formant traçats sobre la imatge sobre els quals fer coses,
fer càlculs sobre la imatge, canviar les mides, moure-la, canviar colors...
per transformat imatges girant-les, retallant trossos, ...
per crear text
per permetre algunes opcions de dibuix sobre la imatge
per fer manipulacions i retocs de píxels
i per seleccionar els colors que s'aplicaran sobre objectes nous creats, quan correspongui (text, omplir de color, ...)

A més, es poden obrir tota una sèrie de Diàlegs, com el de capes, que ajuden a desenvolupar millor tasques concretes
sobre la imatge, doncs ens mostren agrupades les opcions específiques d'aquella àrea de treball. Els "diàlegs" es poden
seleccionar i obrir des de la pantalla principal del Gimp a través de:

  Fitxer -> Diàlegs

A més, es pot aplicar qualsevol funcionalitat del Gimp sobre una imatge ja oberta a través del menú contextual que surt
quan es clica amb el botó contrari a sobre de la imatge.

Optimització d'imatges per a la web

Conversió de format

Els formats suportats per la totalitat de navegadors són JPEG, GIF i PNG (Microsoft Internet Explorer versió 6 o
anteriors encara té problemes amb PNG) Per a convertir imatges d'altres formats als formats acceptats, obriu-les amb el
Gimp i deseu-les amb el nou format:

  Fitxer -> anomena i desa -> seleccionar tipus (per extensió)

Seleccioneu el format i l'arxiu es guardarà amb el nou format i la nova extensió (conservant l'original)
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Mireu les diferències bàsiques entre aquests tres formats més avall, a l'apartat de "Compressió".

Redimensionat (o escalat)

Si la imatge és més gran que les pantalles més usuals (de 800x600 a 1280x800), convé redimensionar-la, al menys la
versió que es visualitza, que pot tenir enllaços a versions més grans de la imatge. Abans de tot, assegureu-vos que veieu
la imatge a la seva mida real (comproveu el valor del zoom al peu de la finestra)

  Imatge -> Escalar imatge

Entreu el valor en píxels per a l'amplada o l'alçada de la imatge, l'altra dimensió es calcularà automàticament. També
podeu entrar un percentatge respecte a la foto original, per exemple si entreu 50%, quedarà reduïda a la mitat. Podeu
deslligar les dues dimensions i entrar-les per separat, però, atenció, deformareu la imatge. A continuació premeu Escalar

Resolució

Amb la mateixa eina "Escalar imatge" podem canviar la resolució, és a dir, la densitat de punts més adequada per a una
imatge que s'ha de veure en pantalla o imprimir. Per a veure en pantalla la resolució màxima és de 72 punts per polzada.
En canvi, per a fer impressions de qualitat escollirem de 300 a 600 punts per polzada. Noteu que en augmentar la
densitat, com que el nombre de punts no varia, disminuirà proporcionalment el tamany de la imatge. Si feu proves amb la
impressora entendreu molt bé el concepte resolució.

Retallat

Per a publicar només una part de la imatge, o per a eliminar-ne una part, es retalla o escapça: En primer lloc, utilitzeu una
eina de selecció per a seleccionar la part que voleu conservar. A continuació, al menú de la imatge:

  Imatge -> Escapça la imatge

Recordeu sempre guardar-la amb un nom diferent per tal de conservar l'original

Compressió

La compressió depèn del format d'arxiu i del tipus d'imatge. Podreu triar els valors de compressió en guardar les

imatges. En general:

imatges format procediment

fotografies JPEG
el Gimp us preguntarà, abans de guardar, per la qualitat. Feu diferents proves, però en general es
recomana un valor de qualitat del 70% al 80% (que correspon a una compressió del 30% al 20%)
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dibuixos i
fotos

PNG
el Gimp us proposarà un nivell de compressió de 0 a 9. De 6 a 9 són valors acceptables que no
comprometran la qualitat de la imatge si es tracta d'un dibuix pla. Recordeu que per a les
fotografies és millor el format JPEG

dibuixos GIF
el Gimp no us preguntarà res, perquè com recordeu, GIF basa la compressió en la indexació dels
colors a 256. No recomanat per a fotos!

Retoc fotogràfic

Les eines de retoc fotogràfic permeten millorar una imatge corregint errors d'il·luminació, enquadrament o exposició.
Moltes de les eines i procediments explicats als tutorials més amunt citats permeten millorar fotos. Sota hi ha les accions
més freqüents, que aplicarem a aquesta imatge:

Contrast

El contrast fa més clars els colors clars, i més foscos els colors foscos, endurint la imatge. Hi han vàries eines:

Des del menú de la imatge, obriu Eines -> Eines de Color -> Brillantor/Contrast Feu lliscar el control a dreta i
esquerra per a augmentar o disminuir el contrast i la brillantor. Si us agrada el resultat, accepteu amb 'D'acord' i si
no 'Cancel·la'.

Des del menú de la imatge, obriu Eines -> Eines de Color -> Nivells. Feu lliscar els trianglets negres que apareixen
sota l'histograma. a la dreta i a l'esquerra, fins a on comença el gràfic, i observeu-ne el resultat. També podeu
establir automàticament el nivell de color amb el botó 'Automàtic', o triar un compta-gotes per a establir manualment
la referència per al negre, el gris o el blanc. Si us satisfà el resultat, premeu 'D'acord' i si no, 'Cancel·la'.
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Des de la paleta general de Gimp, a la pestanya de capes, dupliqueu la capa amb la icona de baix de tot, a la capa
duplicada li canvieu el mode, de 'Normal' a "Sobreposa" (per contrastar), "Multiplica" (per enfosquir), "Pantalla" (per
aclarir)

Balanç automàtic de blancs

Moltes càmeres digitals permeten ajustar l'equilibri de blanc d'acord amb la llum ambiental: interior, sol, núvol, neu... Però
si no, amb el Gimp podeu corregir aquest equilibri de forma automàtica, obrint el menú de la imatge:

  Colors -> Automàtic -> Balanç de blancs
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Proveu també les altres opcions automàtiques: Equalitza, Amplia el contrast, Normalitza, Millora el color

Saturació de color

Permet fer més vius els colors augmentant-ne la saturació. Des del menú de la imatge, obriu:

  Eines -> Eines de Color -> To/Saturació. 

Feu lliscar el control de saturació a dreta o esquerra per a augmentar o disminuir la saturació (si l'elimineu totalment, la
imatge quedarà en blanc i negre). També podeu canviar la saturació d'un sol color primari, seleccionant-lo a la roda del
damunt.

Ressalta vores (augmenta definició)

Si una imatge es troba lleugerament desenfocada, podeu augmentar la definició de les vores dels objectes de la imatge,
amb el filtre que trobareu a:

  Filtres -> Millora -> Afila 
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Seleccioneu el nivell de definició que voleu donar desplaçant la barra de nivell o canviant el valor de la seva dreta.

Mentre estigui activa la casella de previsualització, podreu veure els canvis que es faran a la imatge si premeu el botó de
"d'acord".

Enfocament (unsharp)

Es pot corregir un desenfocament moderat d'una fotografia amb algun dels filtres inclosos amb el Gimp. El més conegut
és unsharp mask, traduït al català com màscara suavitzant . Al menú de la imatge, obriu:

  Filtres -> Millora -> Màscara suavitzant

El diàleg que apareixerà us mostrarà un sector de la imatge.

Cliqueu a l'angle inferior esquerre per a navegar per la imatge fins a la regió que us vagi més bé per a valorar el resultat
(per exemple, en un retrat, la regió seria els ulls).
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Accepteu els valors (radi, quantitat i llindar) per defecte o modifiqueu-los (amb molt de compte) fins que el resultat sigui
satisfactori. Uns valors excessius podrien crear soroll a la imatge o pigmentar els colors. Si us satisfà el resultat, premeu
'D'acord' i si no, 'Cancel·la'.

Imatge animada

GIF animat Per crear GIF animats amb el Gimp, cal tractar cada frame (marc) com una capa. Si teniu les imatges ja

llestes:

Obrir la primera imatge1.
Al menú de la imatge, obrir Fitxer -> Obrir com a capa i seleccionar la primera imatge.2.
Al mateix menú, repetir "Obrir com a capa" per a cadascuna de les imatges3.
Editar (si cal) cada capa per a produir l'efecte desitjat (per exemple, no han de tenir el fons transparent)4.
Obrir el menú de la imatge Filtres -> animació -> optimitzar (GIF) Noteu que Gimp crearà un altre fitxer, és aquest el
que haureu de guardar com animació. Obriu el menú de capes i fixeu-vos que, al costat de cada capa, el Gimp ha
afegit un temps en milisegons, és el temps d'exposició de cada imatge en l'animació. Podeu editar aquests temps
fent-hi doble clic, però respecteu la sintaxi. Exemples: nom (150ms), frame 3 (100ms) (combine)

5.

Per pre-veure l'animació, al menú de la imatge nova feu Filtres -> Animació -> Reprodueix. Finalment, guardar la
imatge seleccionant format GIF i Desar com animació.

6.

Si voleu crear el dibuix animat partint de zero, feu Arxiu -> Nou i creeu una nova imatge. Feu clic a 'Opcions avançades'
i seleccioneu un fons no transparent. Amb les eines de dibuix, creeu la imatge inicial. A la caixa d'eines, obriu la paleta de
capes. Feu clic a la icona 'duplicar capa'. Treballant a la capa nova, feu una lleugera modificació a la imatge. Repetiu els
punts 2 i 3 fins a completar les imatges i procediu, com abans, amb Filtres -> Animació -> Optimitzar, etc.

Opcions més avançades, amb el GAP

Per a fer imatges animades amb opcions més avançades, cal emprar el paquet extra per a Gimp anomenat: GAP: Gimp

Animation Package

Com instal·lar-lo:

Per a GNU/Linux, cap problema, hi és als dipòsits (repositoris de programes). El cerqueu i instal·leu.
Per a Windows: cal instal·lar la versió del GAP específica per a la versió del Gimp que tingueu instal·lada. Hi ha una
versió per al Gimp 2.6.x:

http://www.deviantart.com/download/135464357/GAP_2_6_for_Gimp_2_6_Windows_by_photocomix_resources.zip
Més informació:
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http://photocomix-resources.deviantart.com/art/GAP-2-6-for-Gimp-2-6-Windows-135464357
Per a Mac: no ho he trobat, sembla que ningú ho ha compilat per a Mac encara.

Alguns tutorials sobre el GAP:

Documentació oficial (anglès):
http://www.gimp.org/tutorials/Using_GAP/
http://www.gimp.org/tutorials/Simple_Animations/

Pdf en castellà:
http://www.villatic.org/index.php?option=com_remository&Itemid=88888891&func=startdown&id=14

Eines de selecció

Es disposa de moltes eines diferents per seleccionar trossos d'una imatge, per retallar-los, eliminar-los, copiar-los, etc.
(passa el ratolí per sobre d'aquestes icones de sota en el GIMP i explora les seves possibilitats: selecció rectangular,
el·liptica, lliure, contígua, per color, tisores intel·ligents, del primer pla, per camins...)

Un exemple senzill és el de la icona de vareta, seleccionat a la imatge d'abans, que permet seleccionar regions contígües
basant-se en el color. Per exemple, si tenim una imatge amb un fons homogeni (blanc, en el següent exemple):

podem seleccionar trossos el fons de color blanc de la imatge, si primer punxem sobre la icona de la vareta, i després
punxem sobre els trossos de color blanc que representen el fons de la imatge darrera del pingüí.

Un cop seleccionat, ja els podem eliminar, i llavors el fons ens és mostrat de color de taulell d'escacs a quadrats alterns
grisos i negres (ens indica que el fons de la imatge és transparent).
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Hi ha moltes més opcions de selecció de trossos d'imatges... Explora-ho! Un cop seleccionat un tros d'imatge que no
t'interessi, pots retallar-lo i eliminar-lo, per exemple, i la inversa de la selecció, etc.

Al final, en posar la imatge sobre un document, es veuria el fons de la imatge inicial del color del fons del document:

Exemple: retallar silueta amb tisores intel·ligents i desar amb fons transparent

Per exemple, un altre cas interessant i relativament fàcil és retallar la silueta d'una figura en una imatge, i fer que tingui
fons transparent.

Es pot emprar l'eina anomenada "tisores intel·ligents" per anar dibuixant un polígon que envolti la forma que vulguis
retallar, amb clics del ratolí en els vèrtex del polígon que vulguis fer. En arribar al final i voler tancar el polígon, cal
clicar dos cops a sobre del punt final, que ha de coincidir aproximadament amb el punt inicial.
Es prem intro per convertir el polígon dibuixat amb les tisores en una selecció.
Es retalla la selecció amb "Ctrl+X"
Es pot enganxar la selecció retallada com a imatge nova, a través de l'opció corresponent en el menú d'"Edita >
Enganxa com a > nova imatge".
I es pot desar a disc com a arxiu .png , que manté la transparència.

En aquest darrer pas, totes les opcions que sortiran per defecte en el Gimp per a "desar com" (exportar) a .png ja van
bé, si no se sap què volen dir (recomanació general per a la majoria de funcionalitats del Gimp).

Un dels inconvenients que té l'eina de tisores intel·ligents, és que no pots desfer un dels clics que hagis fet en anar creant
el polígon. I no es pot moure manualment a posteriori la posició dels vèrtexs del polígon creat, ni afegir-ne de nous, etc.
Per poder tenir el màxim control sobre la creació del polígon o silueta per fer selecció lliure, cal emprar l'eina "Traçat" o
"Camins" (en funció de la traducció i versió pot variar el nom), que si que permet totes aquestes funcions més avançades
malgrat no sigui tan fàcil per fer el possible per ajustar-se al gradient de canvi de color en píxels com fan les "tisores
intel·ligents".

Eines de manipulació i retoc de píxels

Hi ha tres eines de manipulació de trossos d'imatges força interessants per lo útils que són i a la vegada relativament
fàcils d'emprar. Són les eines:

clonar1.
cicatritzar (o "saneado", en els menús en castellà)2.
Pixelitzar (com una de les moltes opcions de difuminat)3.

Clonar

Clonar pot ser molt útil, i és per fer còpies de parts de la imatge en altres zones de la teva imatge o d'una altra imatge.
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Cal tenir present que per indicar la zona d'origen per clonar (a partir de la qual volem que es cloni), cal escollir l'eina de
clonar, de-seleccionar tot el que tinguem a la imatge ("Seleccionar > Res"), i escollir la zona d'origen prement sobre la
tecla Control mentre cliquem una vegada amb el punter del ratolí a la zona que ens interessi clonar. Després, deixem anar
la tecla control, escollim una punta de pinzell gran, per exemple, i anem pintant amb el ratolí a una altra zona de la imatge
(o altra imatge) clicant amb el ratolí, de tal forma que va apareixent la zona clonada al nou lloc.

Cicatritzar

Cicatritzar permet arreglar zones de la imatge on hi ha desperfectes, o hem esborrat tal o qual part, i volem que quedi la
"ferida" de la imatge cicatritzada amb el tros d'imatge del voltant. Funciona de forma similar a l'eina de clonar. Un cop
sapigueu clonar, veure que cicatritzar no té més misteri que saber que hem de clicar cada vegada per tornar a pintar amb
la zona que havíem seleccionar inicialment, i no amb el seu voltant.

Pixelitzar

Pixelitzar és força intuïtiu, i es troba a: "Filtres > Difumina > Pixelitza".

Cal seleccionar primer la zona que volem deixar borrosa (la cara d'una persona, etc.), i apliquem aquest filtre sobre aquella
selecció.

Afegir coses en "capes" sobre la imatge

Una de les coses més versàtils dels programes de gestió d'imatges és el fet de poder treballar amb capes d'informació
(com amb els Sistemes d'Informació Geogràfica).

Sovint és molt útil mantenir obert el diàleg de capes (a través de "Fitxer -> Diàlegs -> Capes") per separar per exemple la
imatge del fons del text i cercles que afegim a sobre per il·lustrar part de la imatge, o afegir noms a les seccions de a
imatge.

En desar la imatge en formats d'imatge que no gestionen capes (la majoria, tret del format nadiu .xcf del Gimp que guarda
tota la informació de treball en capes), es mostraran algunes finestres en que les opcions per defecte són molt vàlides per
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començar a treballar.

Més endavant, es poden canviar els paràmetres del desat d'imatge per tal d'aconseguir més possibilitats diferents en el
resultat (per exemple, en el cas png, es pot canviar el nivell de compressió, o afegir un color transparent a la imatge, tot i
que alguns navegadors antiquats (IE 6, per exemple) no mostren les zones transparents com a tal d'aquest format
estàndard d'imatge pixelada sinó amb el color de fons.

Posar text a sobre d'una imatge

En clicar sobre la icona de la "A negra", se seleccionarà l'"eina de text", i s'obrirà un diàleg per escollir el tipus i mida de
lletra, color, i alguns paràmetres més.
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Després, en clicar sobre la imatge s'obrirà un diàleg on podem escriure el text que vulguem, i en tancar la finestra,
s'escriurà el text en el lloc on havíem clicat amb el ratolí.

Mentre mantenim activa la finestra del text, o la selecció del text, podem fer canvis dels paràmetres del text en el diàleg
de text, i aquest canvis es mostren al moment.

Afegir ombres

Cal clicar amb el botó dret del ratolí a sobre de la imatge, i anar a (en Gimp 2.4.x):
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 Filtres -> Llums i ombres -> Ombra

Això mostrarà un diàleg com aquest:

Un cop aplicada la ombra amb els paràmetres de l'exemple anterior, es produirà un efecte d'ombra sobre les vores de la
imatge. Cal notar que si la imatge és totalment rectangular, l'ombra s'aplica sobre tot el rectangle, però si hem retallat o
eliminat la part blanca del fons de la imatge (com en aquest cas amb el pingüí), l'ombra ressegueix la silueta del pingüí.

Processar moltes imatges a l'hora

El Gimp disposa d'un plugin especial que quan s'instal·la, permet processar moltes imatges a l'hora ("Procés per lots" o
"batch process", en anglès), a través de pantalles gràfiques. És l'anomenat "David's Batch Processor" (DBP), que es pot
instal·lar fàcilment en GNU/Linux i M$ Widnows. Per instal·lar-lo en GNU/Linux, cal instal·lar el paquet gimp-plugin-

registry, que conté ja empaquetats una vintena de les extensions més freqüents i útils. Per instal·lar-ho en M$ Windows,
com no existeix amb aquesta compilació feta dels connectors (plugins) del "registre" de connectors, baixarem l'arxiu
corresponent a disc dur, el descomprimirem, i veurem que ens surt un arxiu executable. Hem de col·locar aquest arxiu a:

  C:\Archivos de Programa\GIMP-2.X\lib\gimp\2.0\plug-ins

Llavors obrirem el Gimp (o el tancarem i el tornarem a obrir, si cal), i ens apareixerà el nou menú:

  "Extensions -> Procés per lots..."

Si heu instal·lat la versió en català per a GNU/Linux ( dbp-1.1.7_ca.tar.gz - descarregueu l'arxiu, descomprimiu-lo i llegiu
les instruccions de l'arxiu que hi és a dins anomenat "dbp.html"),
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ó

  "Filtres > Batch > Batch Process..." (per a Gimp 2.6.x)
  "Extensions > Batch Process..." (per a Gimp 2.4.x)

Si hem instal·lat la versió en anglès per a Window$. (veure captura de pantalla a l'inici dels apunts - podeu descarregar el
connector des d'aquí: http://www.ozemail.com.au/~hodsond/dbp-1.1.8.zip).

Un cop obert, veurem quelcom com: http://members.ozemail.com.au/~hodsond/dbp.html

Actualment (versió 1.1.9 per a GNU/Linux, i 1.1.8 per a M$ Window$) només hi ha un petit recull de funcionalitats
utilitzables a través del connector DBP. De totes les pestanyes visibles a la interfície, n'hi ha tres que sovint les farem
servir, a més de la tasca concreta que volguem fer, i són:

"Entrada" / "Input", per afegir les imatges que volem processar1.
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"Reanomena" / "Rename", per escollir el directori de sortida on volem desar les imatges modificades2.
"Sortida" / "Output", per escollir el format de sortida de les imatges.3.

A part d'aquest tres opcions, caldrà que anem a la pestanya de la tasca que volem realitzar. Per exemple, podem
redimensionar moltes imatges a l'hora, a una mida exacta o relativa (en percentatge) de la mida original, mantenint o no
les proporcions dels dos eixos, etc.

Cal tenir present que cal escollir l'opció que ens interessi en el paràmetre "Fit" del redimensionat a mides absolutes:

  "Filtres > Batch > Batch process > Resize >  Absolute > Fit"

Per omissió aquest paràmetre mostra l'opció "Padded". Però veiem que hi ha tres més: "Exactly", "Inside", i "Outside".

Quan escollim l'opció "Fit > Padded", el Gimp afegeix pixels de color de fons de la paleta quan li cal per acabar d'omplir
les vores de la imatge per arribar a la mida especificada sense distorsionar les proporciones de la imatge.

L'opció "Fit > Exactly" fa que la redimensió es faci a les mides exactes que haguem indicat per a amplada i alçada,
distorsionant les proporcions de la imatge general si li cal.

Amb les opcions "Fit > Inside" i "Fit > Outside" la imatge mantindrà les proporcions, i quedarà ajustada al costat més
petit de la imatge original, un cop redimensionat als píxels que hagis indicat (si esculls "Inside"), o al costat més gran (si
esculls "Outside").

Més trucs amb el Gimp

CTRL+Z

O sigui: desfer. La salvació quan ens hem equivocat. CTRL+Z és un estàndard, funciona a tots els programes de
GNU/Linux, Windows i Mac. A més, al Gimp teniu un historial complet d'accions que podeu desfer i refer. Al menú de la
imatge, obriu:

  Edita -> Historial de desfer

Apareixerà una finestra on es representen amb icones totes les etapes que ha passat la vostra imatge durant la sessió. Si
seleccioneu una icona, tornareu la imatge al punt en què estava abans de realitzar les accions següents.

Captura de pantalla

Podeu capturar qualsevol pantalla (web, programes, l'escriptori) per utilitzar les imatges en un manual o tutorial web. Des
del menú general del Gimp:

  Fitxer -> Adquireix -> Captura de pantalla
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Al diàleg que apareixerà, podeu seleccionar tota la pantalla o una finestra, i la possibilitat d'establir un lapse de temps
perquè pogueu fer accions tals com obrir un menú, etc. que apareixerà a la captura.

Premeu 'D'acord' i el cursor es transformarà en una creu. Arrossegueu la creu per deixar-la caure sobre la finestra que
vulgueu capturar.

La imatge s'obrirà amb el Gimp i la podreu editar o guardar en qualsevol format.

Com gravar dreceres de teclat

Les macros o dreceres de teclat permeten realitzar ràpidament funcions molt freqüents sense haver-les d'anar a buscar
pels menús.

Al menú general de Gimp, obriu Fitxer -> Preferències -> Interfície. A la finestra de la dreta, marqueu 'Utilitza
dreceres de teclat dinàmiques' i 'Desa dreceres de teclat en sortir'. Tanqueu les preferències.

1.

Al menú de la imatge, obriu el menú, situeu-vos al damunt de l'opció desitjada, i teclegeu la combinació de tecles
que hi voleu associar. Veureu que la drecera s'incorpora al menú.

2.

Exemple: Després d'haver canviat les opcions a les preferències, obriu el menú de la imatge: Capes -> Colors ->
Automàtic Amb el cursor al damunt de Control de blancs, premeu alhora les tecles MAJ+CTRL+B. La combinació
apareixerà al costat de l'opció del menú i ja serà activa.

3.

Autoria d'aquest document: Lluïsa Núñez i Xavier de Pedro. Algunes imatges són originals o modificacions d'imatges del
manual breu "Introducció al Gimp 2.0", de Raimon Esteve - www.codilliure.org.

Llicència de Copyright Creative Commons, Atribució, Compartir per Igual. http://creativecommons.org/licenses/by-sa
/2.5/deed.ca

Etiquetes: afegits enllaços a tutorials en pdf i video

Esteu accedint com a visitant (Entrada)

1001-Taller-GIMP
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